
                                  

                                                      Release Notes GEOLYMPUS 3.5 
 
 
 

Pre-requisites 
 

Computing and system environment: 
 

• The GeOlympus user interfaces are Java applications integrated into CGGVeritas GeOlympus 
package. A Java Runtime Environment (JRE) or Java Development Kit (JDK) version 1.5 or 1.6 
must therefore be installed locally on each computer running a GeOlympus application. 
Note that the dependencies with the Geocluster XPS database require Java 1.5 and above. 
The JRE or JDK is not provided with GeOlympus. If GeOlympus is the first Java application 
from CGGVeritas installed on your system, you can request the JRE CD, containing all multi-
platform JREs necessary for running CGGVeritas Java applications, from the Distribution 
department at: cgg_distribution@cggveritas.com 
 

• The inversions to update the model in Geostar and the residual static-velocity computations in 
GeoPACS are implemented as native non-Java standalone process, which can be run on either 
the local computer (default mode) or a remote computer; in any case this computer must be a 
PC/Linux platform.  
When such process is launched from the graphic user interface, the integrated Java job manager 
handles the following processes: 
o data transmission to the target machine 
o standalone job execution 
o re-direction of output to the graphic interface 
The remote PC/Linux workstation(s) on which you intend to run a GeOlympus standalone 
process must also be installed with a local Java environment, and they must be previously 
declared in the GsWServices environment variable; for example to declare n01 and n02 
workstations, type:  
setenv GsWServices //n01/GsWJob://n02/GsWJob.  
This preliminary declaration is not necessary when the standalone process runs on the same 
PC/Linux workstation than the GeOlympus application (i.e. in local mode). 
 

• For Geostar, the environment varies according to the inversion type and data size: 
o The Layered Model Inversion (LMI) can be executed as a Geostar process in the local (or 

remote) PC/Linux workstation for any data size, assuming there is enough free space in the 
scratch directory. 

o The Tomographic Inversion constitutes a much heavier process.  
For 2D profiles or small 3D surveys, it can run as a Geostar process on the one or two CPUs 
of the local (or remote) PC/Linux workstation.  
To speed up its execution for mid- to large-size 3D surveys, Geostar can prepare a 
Geocluster job for manual or automatic submission on a cluster of Linux PC nodes. Refer to 
Geostar on-line documentation for more details. 

 

Licensing: 
 
• As explained in the previous section, the applications integrated in the release 3.5 of the 

GeOlympus statics workstation are composed of Java-based Graphic User Interfaces and 



C/Fortran calculation codes, which require different license feature formats.  
All these license features can be grouped in the same file, either in the centralized license file on 
a license server upgraded to FLEXlm 9.5, or in a specific license.lic file integrated in 
GeOlympus installation directory. 
Cgg_distribution can provide floating or node-locked licenses. 

 
• In GeOlympus launch pad, the applications without an active Java license are grayed out. Note 

that the information displayed in the “Licenses” panel from GeOlympus Help menu can be 
erroneous when the listed license features are installed on a remote license server. 

 
 

New features 
 

Job and data management: 
 

• GeOlympus 3.5 applications are interfaced with the Geocluster XPS data server. Auxiliary data 
like Statics, Velocities, Horizons and Mutes can be read or written in the XPS database. The 
Geometry data can be saved and read as XPS Scatter-type dataset, and the first break pick 
times can be saved and read as XPS Others-type dataset. 
Several XPS datasets can be selected and loaded in one go and all loading parameters apply to 
all selected datasets. 

 
• GeOlympus 3.5 applications can read trace sets in SEG-Y standard format; for example 

weathering shots in Geostar or GeoWZ, CMP or Bin gathers in GeoPACS. The models 
computed in Geostar and GeoWZ can also be exported as SEG-Y trace sets. 
In the Setup > File Formats dialogs from the application’s main window menus, you 
can adapt (to some extent) the header’s mapping for non-standard SEG-Y formats.  

 
• Thanks to specific options, Promax velocity, static, horizon and trace set formats are supported. 
 
• Several controls were added in Geostar to define the environment for the execution of the 

tomographic inversion in parallel mode on a cluster of PC (using PTLR3 standalone). 
The default patch name and scratch path on nodes can be modified directly in the Geostar 
interface.  
The Geocluster level and the targeted (cluster) actor name can be defined in specific variables: 

o setenv GCT_P_LEVELS "3100;4100;5000"; setenv LEVEL 4100 defines 
the default level 

o setenv GCTServices img3-32:opteron:img24-16 to declare various PC 
cluster actors 

You can switch between two inversion modes: 
o “Intra-node” (default): the matrix is splitted on the nodes; this mode requires less 

memory per node but the inversion step takes longer 
o “Inter-node” (default): each node receives a copy of the whole matrix, which is time and 

memory consuming but allows faster inversion 
 

• The interactive Picker in Geostar can store picked values directly in the seismic trace header, 
when the “Store FB in header” icon from the Picker toolbar is pressed. 
Reminder: when loading trace sets, the trace headers are cached (in ~/.glrCache directory). 
This cache can be cleared by selecting the “Clear traces cache” from the Session menu of the 
GeOlympus launch pad. 

 
• In the General UI tab of the UI Setup window in Geostar and GeoWZ, an option (non-activated 

by default) permits the backup of the previous version (in .backup file) on project save. 



 

Graphic user interface: 
 

• The X/Y limits of the Geostar or GeoWZ project can be changed. Remember also that a 
polygons digitized on a map view can be used as a mask to bound any surface display. 
 

• The size of the active window (in pixels) can be changed with the Window > Resize 
Frame menu. 

 
• Snapshot tool to capture the active window (with or without border frame) and save the image 

in various formats: .BMP, .PNG, .JPEG, etc. 
 

• A Legend can optionally be displayed in the Map and Section view. This panel that can be 
positioned beside the current view shows a graduated color bar for grid-type displays, annotated 
symbols for point-type displays and annotated lines for curve-type displays. 

 
• Dynamic color histogram in the properties of map grid layers. The palette and its edges can be 

moved. 
 

• In Geostar and GeoWZ, the Control Points can be sorted by increasing or decreasing 
alphanumeric order, or according to “Class” codes that can be defined at project level and 
assigned to selected control points. In the Map view, the control points can be color-coded 
according to their Class (using “Unique” symbol and color per CLASS).   

   

 Geostar 3.5 (including TLR3 and PTLR3 tomographic inversion): 
 

• Reminder: the JMAN_TMP_DIR variable can be set to relocate Geostar scratch files as well as 
temporary files created during the non-parallel inversion jobs (stored in /tmp by default).  
These temporary/scratch spaces should be local, because Geostar uses memory-mapped files and 
may become unstable if such files are accessed via NFS. 
 

• The picking and the interpretation of the surface weathering shots (“LVL” shots) was reported 
from GeoWZ into Geostar, where a Control Point can be defined at the central position of the 
LVL spread, with a radius encompassing the spread length.  
The layer attributes defined at this position can be saved in a CP file for further use in Geostar or 
GeoWZ. Moreover, remember that the layer attribute surfaces computed in GeoStaR can be 
exported and reloaded in GeoWZ. 

 
• When exporting the edited first break pick times in a text file or in XPS, you can choose between 

exporting all picks or only “valid” picks (the ones with QC field equal to 1 in the Traces/FB 
project table). The picks auto-edited during model updates are always exported. 

 
• Automatic refractor branch picking in the Offset View: as soon as “Add Control Point” is 

pressed, an automatic refractor branch picking fitting with the current model parameters is 
proposed on the picks currently displayed in the time-offset graph. 
 

• Various gridding methods were made available to transform point sets into grid surfaces: Inverse 
Distance Weighting, Bicubic Spline, Kriging, Proximity. 

 
• An option was added in the “Iterate” pull-down list to realize distinct residual iterations for 

short-wave statics. So that once a model is updated after the LMI or Tomographic inversion, you 
don’t have to re-run the whole inversion if you just want to modify the parameters of the residual 
Gauss-Seidel decomposition for short-wave statics. 



 
• In the tomographic inversion dialog, instead of fixing lx/ly/lz values between 0.1 and 10.0, you 

can choose between four levels of smoothing for the preconditioning of the matrix: No 
smoothing, Weak, Moderate (recommended default), Strong. 
 

• For the tomographic update, the “Additional” parameterization dialog contains damping 
parameters representing the maximum deviation allowed in terms of velocity and travel time 
from the “ideal” solution (theoretical). The defaults are 100 for the velocity deviation and 0.1 for 
the time deviation, which means that we allow the tomo solution to deviate by 
[0.1*standard_deviation] from the ideal solution. 
 

• The tomography ray paths for sampled shots can be overlaid on the resulting Earth model or 
displayed (and browsed in depth) in the Map view. The shots can be selected in the “Additional” 
parameterization dialog. 
 

• The raypaths and traveltimes computed during a tomographic update can be stored for a 
subsequent tomographic update with different inversion parameters. Setting the number of 
“Geological iterations” to 0, the computation will stop after the ray-tracing phase. 
 

• When generating a Geocluster job for the tomographic inversion in parallel mode on a cluster of 
PCs, Geostar searches the TEMPLATES folder containing the model job successively in the 
user's home, project and installation directories.  
The parameters are replaced with the site or user-defined parameters from Geostar during the job 
generation. Remember that the job (gsrXXXXX.job.gsl) and the data (gsrXXXXX.job) 
files are generated in a GEOSTAR directory created in the directory from where GeOlympus 
was launched. The output of the tomographic update (.res file) is also retrieved in the 
GEOSTAR directory. 

 
• The maximum Ray penetration depth can be used as model base for statics calculation on an 

updated tomographic model. 
 

• On a tomographic model, the statics can be computed using a layer elevation from a preliminary 
layered model as model base (floating pseudo-datum). Like the floating pseudo-datum obtained 
by smoothing and shifting down the topographic elevation, the chosen layered model surface can 
be smoothed and shifted down, if necessary. 
The floating pseudo-datum can also be a loaded or calculated surface (using “Load Basemap” or 
“Add calculated item” options in the Map view). 
 

• In Geostar and GeoWZ a plug-in accessible from the Project menu of the main window permits 
the calculation of Statics for “external” geometries.  Through the "External statics calculation" 
dialogs you can load the new geometry and select an existing model to compute statics for the 
loaded points.  
Obviously it will not be possible to compute valid statics for loaded points that are too far from 
the selected model limits. 

 

GeoWZ 1.3: 
 

• Multi-uphole Excel files with one column per uphole (in the same sheet) can be decoded. 
 
• A plug-in accessible from the Project menu in the main window permits the decoding of uphole 

data issued from InterbaseX in “Finder DB” ascii format. 
 

• Surfaces and models can be computed from uphole curves only. But statics can only be 
computed for loaded shot/receiver geometry. 

 



• A table compiling the main statistics (min/max, average) for all existing surfaces can be 
displayed. 

 
•  “Set as Topography” option replaces the project elevations (free surface) by the selected layered 

model surface. Doing this, the un-saved models and related statics are lost. 
 

• Various gridding methods were made available to transform point sets into grid surfaces (Inverse 
Distance Weighting, Bicubic Spline, Kriging, Proximity). 

 
• “Calculate surface” includes additional functions to compute the vertical times on a given 

elevation surface:  
atTime(<Model>,<Surface>) computes the travel times from the ground surface to the 
defined surface with the model's velocities  
atAvgVelocity(<Model>,<Surface>) computes the travel times from the ground 
surface to the defined model surface using the defined constant velocity. 

 

GeoPACS 1.9: 
 

• GeoPACS 2D parameters: "Split statics" can be used to calculate different static values for 
forward and reverse shot traces. 
 

• "Horizon weight" in GeoPACS horizon-based parameters allows horizon's weighting (within 
Interval) during statics calculation - for advanced users only. 
Wn with n = "quality" or weighting factor for the defined horizon interval. 
n = -3 - The cross-correlation from this portion of horizon will not be used for statics 
n = -2 - Phase skip in this interval 
n = -1 - Tectonic fault: the cross-correlation is not computed for this portion of horizon 

 
 

Fixes 
 

 
Geostar 3.5: 

 
• The rays that “escape” from the tomographic model limits are automatically canceled. It 

concerns particularly some rays that were traveling in the air (above the topography) at the 
bottom of sharp valleys. 
 

• The Ray density and Ray penetration depth are also displayed for the tomographic inversions 
executed on the local workstation. These graphic layers can be overlaid on the resulting Earth 
model or displayed (and browsed in depth) in the Map view. 

 
• The execution log for the mono- or multi-CPU tomographic inversion was completed and some 

useless information was removed (at least in the part related to the TLR3 or PTLR3 standalone 
execution). 
The elapse time is updated for the tomographic inversions executed on the local workstation. 

 
• Fixed random problem causing wrong values to be exported for Tomo statics and statics 

computed with the Floating pseudo-datum downward continuation mode. 
 

• A bug which prevented the correct simultaneous export of Elevation and Thickness layers, 
depending of the layered model smoothing type (smooth on elevation or on thickness), was   
fixed. 



 
GeoWZ 1.3: 
 
• The option to export short-wave statics from GeoWZ was removed (not meaningful). 

 
 

Known limitations 
  

 
The porting of the Geocluster application Sditr to Java for integration in the GeOlympus 
statics workstation is in progress.  
Sditr derives statics from the picking of a single refractor that can be followed over the 
whole survey extension. The picking is done on first break stacks (not on elementary 
traces like in Geostar) and Sditr includes options for Source/Receiver Repositioning and 
Refractor Velocity Analysis. 

 

 Input/Output: 
 

• To automatically decode known format files without extension, uncheck “Check Extension” in 
Setup > File Formats > Edit dialog for the relevant format definition. 

 
• When the tomographic model update is executed in parallel mode on a remote cluster of PC, the 

execution log cannot be retrieved in Geostar (no reliable way to locate it). You will find this 
listing file where the Geocluster job returned it (in the LISTS sub-directory of the Geocluster 
Project for example). 

 

Geostar 3.5: 
 

• As long as you have not read a first set of geometry and picks data, the Raw Traveltimes 
cannot be displayed in the section view. 

 
• Combining Smooth thickness and Smooth elevation options for the different layers 

of a given layered model is not currently allowed. You can by-pass this limitation by creating the 
initial model in GeoWZ using the same geometry. 

 
• It’s difficult in Geostar to generate 3D models for 3D surveys with large gaps (more than twice 

the smaller smoother size for layered models), because surface fitting is very time consuming in 
large areas where there is no data. Additionally, if your model has more than 50x50 bi-cubic 
patches, the computation matrix can exceed the available memory (it will work, but again very 
slowly). 
The option "Allow holes in surfaces for 2D Survey geometry" on Data Handling tab of UI 
Setup dialogs is intended primarily for sparse 2D surveys and it was not tested yet for 3D 
geometries. 

 
• When exporting layer grids with “Export layers” or “Export Surface”, the cell size depends on 

the layered model parameters and differs for velocity and elevation/thickness grids if the related 
smoothers have different length.  
An option may be added to control the output cell size. 

 
• The tomographic inversion can be executed under Linux 2.4 or 2.6 in 32-bit mode, and the 

parallel inversion is supported on a PC cluster running Geocluster level 3100 or 4100 with i686 



or PIV processors. 
Please contact gvrsupport.master@cggveritas.com if you intend to run this tomographic 
inversion on another PC/Linux configuration. 

 
• The tool to estimate the optimal cell size and number of CPUs for the tomographic model update 

is still in construction. 
 

• You may sometime read the following set of messages in the execution log of the tomographic 
inversion: 

Stopping condition:           3 
********** The system is ill conditioned. **** 
********** No convergent solution can be found! 
********** Try to change smoothing or precond 
*********** parameters and/or cell sizes! 
Update(min,max,mean):    1642.595       4421.259       2266.879 
It means that the least-squares iterative inversion encounters difficulties to converge towards 
an “exact” solution, but it will not systematically stop the job. If the resulting model is not 
satisfactory, you should try to decrease the matrix pre-conditioning smoothers (lx, ly, lz 
parameters). 
Stopping condition:           5 
The system is (probably) incompatible. 
Reasonably good least squares solution           is found 
Update(min,max,mean):    1531.546       4373.795       2278.901 
“Incompatible” refers here to the set of linear equations built by TLR3, which is by design an 
approximation of an “ideal” minimization solution; but a “Reasonably good least squares 
solution is found”, so the iterative inversion process can continue. 

 
• The Earth model display for a tomographic model is wrong when “PolyPosition” profile is a 

sinuous line, but correct when the profile is made of straight segments. 
 

GeoPACS 1.9: 
 

• The improvement of the MACROBIN option with shot/receiver packing rather than only bin 
packing is in progress. Remember that this option can be implemented to compute mid-wave 
residual statics. 
 

• The horizon picking must fit within the CMP or Bin data area. 
 

• In 3D mode, the output velocity function set must have at least two inline and two crossline 
nodes, with a minimum step of two bins between nodes. 
 

• When you click on Save/Check button to confirm that the current job is correct and that 
changes are saved, no message is displayed. The message appears only in case of an incorrect or 
incomplete coding. 

 
• As there is no coordinate information in the output datasets, the Map and Section views are not 

operational in the 2D mode.  
In the Map view, the computed 3D horizon items can be displayed, even if they are grayed. 

 

GeoWZ 1.3: 
 

• Interpreted uphole tables in Excel format must be converted into text (.cvs) uphole tables to be 
decoded. 

 


